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1. Computer Memory
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1. a (i) b. (i) c. (ii) d. (iii)
a. byte b. nibble c. RAM d. Hard disk
3. a. The basic unit for measuring the memory of a computer is byte.

b. Pen drive is used to store data temporarily for transportation.

. Primary memory is the main memory of a computer system from which the CPU can access
data directly.

d. Cloud storage site is an online location that allows us to store data online.
e. Secondary storage system

4. RAM stands for Random Access Memory, it is the primary memory of a computer system. Its
content can be accessed by the CPU directly. It is volatile in nature.

ROM stands for Read Only Memory, It is non volatile storage device. Data stored in this storage
device is not lost even if the device is shut down.

5. a.Cloud Storage  b. Memory card c. Blu-Ray disc
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2. The Computer Timeline
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1. a (i) b. (i) c. (iii) d. (i)

2. afF b. T c.F d. F

3. a. Microprocessor b.IBM 360 c. Pascaline d. Vacuum tubes

4. a.John Napier created a manually-operated calculating device in 1617, called Napier's Bones.

b. Analytical Engine was the first fully programmable calculator.
¢. ICs were used in the third generation of computers.
d. Features of fourth generation computers are:
e Reduction in the size of computer
e More reliable than the earlier generation of computers with a great storage device
e Extremely powerful and can process millions of instructions per second
5. a. Dev's mother is talking about the Third Generation Computers.

b. Fifth Generation Computers are used currently.
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Periodic Assessment-1
(Based on chapters 1 & 2)

1. a.Pendrive b. DVD c. Hard Disk d. Vaccuum Tubes
2. a. lel7 b. 1837 c. 1822 d. 1970 e. 1950
3. a. (iii) b. (iv) c. (i) d. (v) e. (i)

3. Managing Files and Folders

........

Answer: Sub-folder
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1. a (i) b. (ii) c. (i) d. (iii)

2. a. Start b. Task view c. Ctrl+C d. File
3. a.Task View b. Recycle Bin c. File extension d. .doc
4. a.Recycle Bin

b. A folder is a file cabinet where we can store our files and other sub folders.

¢. Start menu is used to access all the apps of your computer from one location.

d. The work we do or the information we collect is saved in the form of files. For example, the
drawing we make in Paint, the story or poem we type in Word, or the songs and videos we
download from the Internet, everything is stored as separate files on the computer. To rename
a file, follow these steps:

e. To delete a file or a folder, follow these steps:
© Go to the location of your file.

@ Right-Click on the file and select the Delete option.
5. a.Admin b.3 c.3 d. one

e. MS PowerPoint
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a. 14 b. 23 c. 06

4. Images and Objects in Word 2010
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Answer: Through
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1. 1.a() b. (iii) c. (i) d. (i)

2. a.Rotate b. Insert c. Wrapping d. WordArt

3. afF b. T cT d. F

4. a. Wrapping text refers to how the text is positioned around objects or images.

b. Format Tab
¢. To apply WordArt to our document, follow the given steps:
@ Click on the Insert tab.
@ Click the WordArt option.
© Select the desired WordArt style.
O Type your text in the text box to apply WordArt effect.
d. To add text into a shape, follow the given steps:
@ select the shape and right-click on it.
@ Choose the Add Text option.
©® Type the desired text.
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Periodic Assessment-2

(Based on chapters 3 & 4)
a. Folder b. Pictures Library c. Videos Library d. Word File
a. WordArt b. Illustrations c. Resizing handles d. Format tab
e. Folder f. Recycle Bin

l
& N
a. WordArt b. Folder c. Recycle Bin d. Formatting
e. Graphics f. Task View

Test Sheet-1

(Based on chapters 1 to 4)
a. (i) b. (ii) c. (iii) d. (i) e. (iii)
f. (i) g. (i) h. (iii) i. (iii)

a. nibble b. Start c. Insert d. Wrapping

e. Vaccum Tubes  f. WordArt

a.T b. F cF d.T e F
a. (v) b. (iv) c. (i) d. (ii) e. (iii)
a. Yottabyte b. Recycle bin c. Insert d. John Napier

e. Start Menu lists all the application installed in the computer at one place.
a. To rename a folder, follow the given steps:

© Right-click the folder that you want to rename.

@ Select the Rename option.

® Type a new name and press the Enter key.

b. Word 2010 provides an option to change the appearance of the text through the WordArt
feature.

To apply wordart to your document, follow these steps:
@ Click on the Insert tab.

@ Click the WordArt option.

©® Select the desired WordArt style.

@ Type your text in the text box to apply WordArt effect.
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c. Features of fourth generation of computers:

e Reduction in the size of computer

e More reliable than the earlier generation of computers with a great storage device
e Extremely powerful and can process millions of instructions per second

d. Secondary storage devices are high capacity storage devices that can store a lot of data.
It is non-volatile, which means the data is stored permanently. Hard disk and CD-ROM are
examples of secondary storage devices.

5. Creating Tables in Word 2010

1. a (i) b. (i) c. (iii) d. (iii) e. (ii)
2. afF b. T cT dF

3. a. (i) b. (iv) c. (i) d. (ii)

4. a.lnsert Tab b. Layout Tab c. Two times d. Insert Row below

5. a.Table move handle is used to move the table.

b. Table Styles option
c. There are 4 alignments in word.

d. To enter data in a table, click on the cell and start typing. Press enter to keep the contents
of the cell.

e. To insert a column in a table, follow the given steps:
© Right-click in the cell where you want to insert column.
@ Click on Insert option.
® Click on Insert Rows Below option.
O select the desired option.
@ Click on OK button.
f. To apply Border and Shading styles, follow the given steps:
@ Select the table and click on the Design tab.
@ Click on down-arrow in borders.
® Modify the Style, Color and Width options from the Borders tab.
@ Click the down arrow button of the Fill option under the Shading tab.

@ Choose the colour of your choice.
@ Click on the OK button.

on,
6 STrackpad (Version 1.0)-IV (Answer Key)

L



6. Used to split a cell into rows or columns.

Combine two or more cells to create a larger cell.
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a. 30 b. dec efc

6. Introduction to PowerPoint 2010
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1. a (i) b. (iii) c. (i) d. (i)
2. a.Slide b. Quick Access Toolbar c. Title
d. Placeholder
3. a.Ribbon b. Normal View c. F5 key d. Reading view

4. a. A presentation is a sequential display of information using text, graphics, audio, video and
animation. Presentations are widely used at offices, schools, seminars, etc. to express and
explain ideas to a group of people.

b. Two components of PowerPoint:

(i) Title Bar: It is present on the top of the PowerPoint window. It displays the name of the
presentation you are working on.

(i) Quick Access Toolbar: It provides shortcuts to commonly used commands like Save, Undo
and Redo.

c. To save a presentation we will follow the given steps:
@ Click on the File tab.
@ Click on the Save or Save As option.
@ Click on Browse to select a location to save the file.
@ In the File name box, type the name of the presentation.
@ Click on the Save button.
d. To delete a slide, follow the given steps:
© Right-click on the slide you want to delete from the Slide Navigation Pane.
@ Click on the Delete Slide option
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e. PowerPoint 2016 is an application software developed by Microsoft. It allows us to create an
attractive, eye-catching and a professional presentation. We can add many exciting effects
like audios, videos, pictures, charts, etc. to our presentation.

5. She can delete from the Slide Navigation Pane and can delete the Slides.

{coDING Z®N=}

1. NOITATNESERP 2. SLIDE

Periodic Assessment-3

(Based on chapters 5 & 6)
1. o) ol B o)
T Click to add title ~ ©
Slide Navigation Pane
Click to add subtitle >
‘ =
T

2. a.Tab b. Alt + End c. Down Arrow d. Alt + Page Up key

e. Alt + Home f. Alt + Page Down key g. Shift + Tab

h. Up Arrow

7. More on PowerPoint 2010
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Answer: Slide sorter view
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1. a ) b. (iii) c. (i) d. (ii)
2. a.Normal b. Presenter c. nine d. Slide show
a. The slide layout is the arrangement of text, images, ClipArts, charts, etc. on a particular slide.
b. Outline view displays the text of each slide on the left pane.
¢. To change the theme, follow these steps:
© Click on Design tab.
@ Select a theme in the Themes group.
d. To view a presentation in slideshow, follow these steps:
@ Click on the Slideshow Tab
@ Click on the From begining option in the Start Slideshow group.

4. Reading view is used when you want to view a presentation not in full screen but in a window
with simple controls that make the presentation easy to review.

Slide Show view is used to run a presentation on full-screen mode.

8. Blocks in Scratch

(:’_,/;\{ Page-80
Answer: Sound bloc-k-
B = N SSESSYOURSELF mn il - I
L a (i) b. (i) c. (ii) d. (i)
2. arT b. F cF dF

3. a.lLogical Operators are the operators that are used to make logical decisions in a program.
b. Looks blocks are used to change the appearance of the sprite.
c¢. "Say _ for _seconds" block displays a speech bubble for a specific amount of time.

d. Control block have looping blocks which are used when the same blocks have to be repeated
for a number of times.

—
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Repeat block: This block repeats a set of blocks for a given number of times.
Forever block: This block keeps on repeating a set of blocks till the stop button is clicked. It
is similar to repeat block and expands automatically to accommodate the blocks you snap
inside it.

e. Arithmetic operators are used to perform arithmetic operations in Scratch. Addition and
Subtraction operators are examples of arithmetic operators.

f. Greater than: Greater than operator is used to check if one operand is greater than the other.
Less than: Lesser than operator is used to check if one operand is lesser than other.
Equals to: Equals to operator is used to see if two operands are equal.

4. a.This block is used to add sound to our scripts.
b. This block is used to move the sprite to a specific location based on their x, y coordinates.
c. This block is used to set the size of the sprite.

d. This block is used to pause the script for a given time.
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9. Drawing Shapes in Scratch
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Answer: erase all
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1. a (i) b. (i) c. (i) d. (ii)
2. a. () b. (T) c. (F) d. (T)

3. a. Forever loop is used to execute a block of statement endlessly.

b. Pen block is used to draw shapes when the sprites move.

c. Wait block is used to pause the script at any point which helps used to monitor the working
of the script.
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clicked

set pen color to

set pen size to o
repeat
move o steps

3
turn (X o degrees

clicked

set pen color to
set pen size to 9

move o steps

{coDING Z@N=}

Do it yourself

10. More on Internet

7’
{_/ iPage-99
\

........

Answer: Homepage

Trackpad (Version 1.0)-IV (Answer Key) ¢ 11 r



b 4 N =
B = B A5555S YOURSELF 'y N - I

1 a ) b. (ii) c. (i) d. (ii)

2. a.web pages b. refresh c. HTML d. Address bar
3. a. (i) b. (iv) c. (i) d. (ii)

4. a. Web browser is used to surf the Internet.

b. Hyperlink is a special piece of text that has the ability to jump to different part of the webpage
or a different webpage.

c. Internet has enormous amount of information which is available to everyone, everytime. It
also allows us to buy and sell things online.

d. To avoid cybercrimes, do not interact with stranges and do not open e-mail from sources
you don't know and trust.

e.Internet explorer is a web browser. Titlebar, fabourites, addressbar and titlebar are components
of Internet explorer window.

{CoDING Z®N=}

a. www.google.com b. www.facebook.com

c. www.twitter.com d. www.wikipedia.org

11. categories of Robots

B ;M ASSESS YOURSELF
1. a. () b. (i) c. (ii) d. (ii)
2. a. Autonomous b. Atlas c. Pre-programmed

d. Augmenting
3. a. Alrefers to software construct designed to mimic human intelligence.

b. WoeBot is a therapist robot designed to offer convenient care to people struggling with
depression by mimicking human conversation and offering help and companionship to its
users.

c. Heartlander Robot is used to deliver treatment to delicate locations in the body like the heart.
d. Augmenting robots are designed to enhance human capability or replace the abilities,

a human may have lost. Prosthetic Limb or Artificial Limb is an example of augmenting robots.
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a. Atlas b. Augmenting robots c. Woebot
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Periodic Assessment-4
(Based on chapters 7to 11)

a. This block is used to make the sprite say something for a few seconds.
b. This block is used to switch the sprite's costume to the next costume.
¢. This block is used to add sound to the script.

d. This block is used to add sound effects to the script

e. This block is used to hide the sprite.

a. (iv) b. (iii) c. (ii) d. (i)

a. CyberKnife b. Sophia c. Drone controller

Test Sheet-2

(Based on chapters 5to 11)

a. (i) b. (iii) c. (i) d. (ii) e. (ii)
f. (i) g. (ii) h. (i)

a. placeholder b.9 c. sound d. pen down

e. address

a.F b. F cF d.T e F
a. (v) b. (i) c. (i) d. (iii) e. (iv)
a. Pen block b. It is used to surf the Internet. c. Sophia

d. Forever loop e. Woebot f. It is used to modify the text in a slide.

a. To save a presentation, follow the given steps:
@ Click on the File tab.
@ Click on the Save option.

® Navigate to the location where you want to save the file.
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@ In the File name box, type the name of the presentation.
@ Click on the Save button.

b. Wait block is used to pause the execution of the block and monitor the execution and working
of the script.

¢. Hyperlink is a special piece of text that has the ability to jump us to a different location on
the same webpage or a different website.

d. Augmenting robots are designed to enhance human capability or replace the abilities, a human
may have lost. They are used in medicines. Example of Augmenting robots is Exoskeleton
which is used to lift heavyweight objects. Paralysed man walks with the help of mind-controlled
exoskeleton. Prosthetic Limb or Artificial Limb is also its example.
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